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Picketlink with Microsoft ADFSv2 

We use the Portecle tool to create the key store file. 

Download the Portecle tool using the link (https://sourceforge.net/projects/portecle) and 
extract the down load file and use it. 

Click the file to open Portecle tool   

<Portecle_Tool_Extract_Folder>/ portecle.jar 

In the Portcele tool we do the following 

 Create a certificate for the JBOSS container 
 Export the ADFS Token signing certificate  
 Import ADFS Token signing certificate into a key store file 
 Export the keystore certificate file and then import it into the certificate store used 

by ADFS 

List of the content sections 

Secure or Claims aware Web Application and picket link with the configuration files 

In ADFS relying party configuration, under the signature tab add this certificate (i.e. the 
certificate with which the Java application was signed) 

Web application Screen shots. 

Add relying party in ADFS 2.0. 

Reference web site links. 
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Create a certificate for the JBOSS container 

 

1. Select the new key store option from File Menu section to create the key store. 
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2. Select the JKS option and click the “OK” button. 

 

3. Select the Generate key pair from “Tools” Menu section. 
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4. While generating the key value pair select the Key algorithm as RSA and Key size as 1024 
and then click the “OK” button. 

 

5. While creating the key value pair the Common name fully qualified domain name for 
example sys09.jboss.com and enter all the key values to click the “OK” button. 
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6. Give the key store alias name as sys09.jboss.com and to click the “OK” button. 

 

7. Give the key pair entry password (this needs to be used on the picketlink-idfed.xml for the 
attribute “SigningKeyPass”) and then click the “OK” button.  
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8. Generate the key value pair alias name as sys09.jboss.com and to click the “OK” button. 

 

9.  Select the Save key store option from File Menu section to save the key store file. 
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10. Give the key store password it can be used the picketlink-idfed.xml name “KeyStorePass” 
and to click the “OK” button. 

 

11. To click the “Save” button to save the keystore with genereated key value pairs. 
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Configure the keystore on jboss server 

Moved the newly created jboss.jks keystore file moved to <Jboss_Home>/server/default/conf 

Configure the jboss.jks key store file in the config file mentioned below 

File Location : <Jboss_Home>/ server/default/deploy/jbossweb.sar/server.xml 

  <Connector protocol="HTTP/1.1" SSLEnabled="true” port="8443" 
address="${jboss.bind.address}" 

           scheme="https" secure="true" clientAuth="false" 
 keystoreFile="${jboss.server.home.dir}/conf/jboss.jks"  keystorePass="jbosspass" 

            sslProtocol = "TLS" /> 

 

This completes securing the JBOSS container  

 Export the ADFS Token signing certificate
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1. Right click the ADFS Token signing certificate and go to Details tab section.  

 

2. To click the “Copy to File” button to export the ADFS Token signing certificate. 
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3. Select the Base-64 format option to export the certificate. 

 

4. Save the certificate file name as sys09.jboss.com.cer. 
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5. Export the ADFS Token signing certificate successfully from the ADFS section (ADFS2.0 -> 
Service ->Certificates) 
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Import ADFS Token signing certificate into a key store file 

Follow steps from 1 thru 11 in the section (Create a certificate for the JBOSS container) 
create a certificate for the JBOSS container to create another key store file with the name 
composer5_keystore.jks.  

1. Given below are steps to generate key value  

 
2. Save the key store file with the name composer5_keystore.jks 
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3. Import the ADFS token signing certificate sys09.jboss.com.cer on the key store file 

composer_keystore5.jks.This needs to be used on the web application configuration file  
picketlink-idfex.xml under the tag KeyProvider  
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4. Click the “yes “button to import trusted ADFS Token signing certificate with key store 
(composer5_keystore.jks.) 

 

5. After importing the ADFS Token signing certificate into the composer5_keystore.jks file give 
the certificate alias name as adfs_token_sign. 
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Export the key store certificate file and then import it into the certificate store 
used by ADFS 

1. Select the generated key value pair name as sys09.jboss.com and right click and choose 
the export option and select the PEM Encoded options to.  
 

 
 

2. Create the certificate name as composer5.cer. 
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3. Create the ADFS relying party name as Java-Picketlink. 

 
 

4. Add the composer5.cer certificate file on ADFS relying party name as Java –Picketlink 
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Secure or Claims aware Web Application and picket link with the configuration 
files 

See the Picketlink documentation on how to configure your web.xml, jboss-web.xml and 
picketlink-handler.xml, picketlink-idfex.xml, picketlink-sp-jboss-beans.xml and 
context.xml. 

In the web application we have created the servlet name as Test and in the web.xml 
mentioned role name as Enterprise Admins is a group name only that group member 
can access the serlvet method. 
Web.xml 
<?xml version="1.0" encoding="ISO-8859-1"?> 
<web-app xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
 xmlns="http://java.sun.com/xml/ns/javaee" 
xmlns:web="http://java.sun.com/xml/ns/javaee/web-app_2_5.xsd" 
 xsi:schemaLocation="http://java.sun.com/xml/ns/javaee 
http://java.sun.com/xml/ns/javaee/web-app_2_5.xsd" 
 version="2.5"> 
 <display-name>PicketLink Application</display-name> 
 <description> 
    Just a Test SP 
  </description> 
 <security-constraint> 
  <web-resource-collection> 
  <web-resource-name>PicketLink Application</web-resource-name> 
   <url-pattern>/Test</url-pattern> 
   <http-method>POST</http-method> 
   <http-method>GET</http-method> 
  </web-resource-collection> 
  <auth-constraint> 
   <role-name>Enterprise Admins</role-name> 
  </auth-constraint> 
 </security-constraint> 
 <security-role> 
  <description> 
    </description> 
  <role-name>Enterprise Admins</role-name> 
 </security-role> 
 <welcome-file-list> 
  <welcome-file>index.html</welcome-file> 
 </welcome-file-list> 
 <servlet> 
  <description></description> 
  <display-name>Test</display-name> 
  <servlet-name>Test</servlet-name> 
  <servlet-class>com.sample.Test</servlet-class> 
 </servlet> 
 <servlet-mapping> 
  <servlet-name>Test</servlet-name> 
  <url-pattern>/Test</url-pattern> 
 </servlet-mapping> 
 
</web-app> 
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Jboss-web.xml 

<?xml version="1.0" encoding="UTF-8"?> 
<jboss-web> 
 <security-domain>sp</security-domain> 
</jboss-web> 
 

Context.xml 

<Context> 
 <Valve 
className="org.picketlink.identity.federation.bindings.tomcat.sp.SPPostFormAut
henticator" /> 
</Context> 
 

picketlink-sp-jboss-beans.xml 

<deployment xmlns="urn:jboss:bean-deployer:2.0"> 
 
 <application-policy xmlns="urn:jboss:security-beans:1.0" name="sp"> 
   <authentication> 
     <login-module code = 
"org.picketlink.identity.federation.bindings.jboss.auth.SAML2LoginModule"  
                   flag = "required" /> 
   </authentication> 
 </application-policy> 
  
</deployment> 
 
picketlink-handlers.xml 

<Handlers xmlns="urn:picketlink:identity-federation:handler:config:1.0"> 
 <Handler 
 class="org.picketlink.identity.federation.web.handlers.saml2.SAML2LogOut
Handler" /> 
 <Handler 
 class="org.picketlink.identity.federation.web.handlers.saml2.SAML2Issuer
TrustHandler" /> 
 <Handler 
 class="org.picketlink.identity.federation.web.handlers.saml2.SAML2Authen
ticationHandler"> 
 </Handler> 
</Handlers> 
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picketlink-idfed.xml 

<PicketLinkSP xmlns="urn:picketlink:identity-federation:config:1.0" 
 ServerEnvironment="tomcat"> 
 
 <IdentityURL>https://sys09.jboss.com/adfs/ls/</IdentityURL> 
 
 
 <ServiceURL>https://localhost:8443/EmpApp/Test</ServiceURL> 
 <!-- Only trust IDP SAML Responses from the following IDP domains --> 
 <Trust> 
  <Domains>localhost</Domains> 
 </Trust> 
 <KeyProvider 
 
 ClassName="org.picketlink.identity.federation.core.impl.KeyStoreKeyManag
er"> 
  <!-- Path to keystore of certificates --> 
  <Auth Key="KeyStoreURL" 
Value="C:\JavaSecurity\composer5_keystore.jks" /> 
  <Auth Key="KeyStorePass" Value="jbosspass" /> 
  <!-- Which certificate in the keystore do we use ourself for 
signing the  
   SAML AuthnRequest to the IDP? --> 
 
  <Auth Key="SigningKeyAlias" Value="sys09.jboss.com" /> 
  <Auth Key="SigningKeyPass" Value="jbosspass" /> 
  <!-- Every SAML Response from the IDP is/mustbe signed and the 
signing  
   must be checked to makeu use the IDP can be trusted 
Key=Domain name for which  
   this certificate can be used to check the signing 
Value=Aliasname in keystore --> 
  <ValidatingAlias Key="sys09.jboss.com" Value="adfs_token_sign" /> 
 </KeyProvider> 
 
</PicketLinkSP> 
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Web application Screen shots 

Web application access on the web browser. 
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Click submit button it will redirect to ADFS login  with the SAML request token which is 
created by Picketlink and give user credentials  when prompted  
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After successfully logon we are redirected to the screen below 

 

When user doesn’t have access we get the error shown below. 
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SAML Request Token 

Using SAML Tracer plug-in on Firefox web browser to view the Request SAML Token 
which is created by picketlink and passing through the ADFS Identity provider (IP). 
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SAML Response Token 

In Firefox browser go to the menu section (Tools->Add-ons) search and include the 
Saml Tracer Plug-in and restart the Firefox browser or Install the plug-in using the link 
https://addons.mozilla.org/en-US/firefox/addon/saml-tracer/.   

Using SAML Tracer plug-in on Firefox web browser to view the Response SAML Token 
which is created by ADFS (IP) and picket link validate the user group on the web 
application after returns back to the web application  

Below screen shots to show the SAML response token 
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Add relying party in ADFS 2.0 

1. Open ADFS 2.0 from Start Programs Administrative ToolsADFS2.0 Management 

 
2. Select Relying Party trust from left pane 
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3. Right click on relying party Trust and select “Add Relying party Trust” menu. 

 

4. Click Start button 
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5. Select the 3 rd option and Click Next button. 

 

6. Enter Display name and description and click Next button. 
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7. Select the ASFS 2.0 Profile option. 

 

8. Browse the “composer5.cer” and click Next. 
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9. Select the “Enable support for SAML 2.0” option and Click Next button. 

 

10. Add the Relying party service URL and click Next button. 
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11. Select the Permit all user Option. 

 

 

12. Click Next  
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13. Click “Next” button and click Close Button 

 

 

14. Now this will open a new window called as “Edit Claims Rules” 
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15. Click “Add Rule” button and select the “Send Claims using Custom Rule” and Click Next 
Button. 

 

 

16. Mention claims rule name and add the custom rule. 
c1:[Type == 
"http://schemas.microsoft.com/ws/2008/06/identity/claims/windowsaccountname"] 
 && c2:[Type == 
"http://schemas.microsoft.com/ws/2008/06/identity/claims/authenticationinstant"] 
 => add(store = "_OpaqueIdStore", types = ("http://sys09/internal/sessionid"), query = 
"{0};{1};{2};{3};{4}", param = "useEntropy", param = c1.Value, param = c1.OriginalIssuer, 
param = "ID", param = c2.Value); 
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17. Click “Add Rule” button and select the “Transform Incoming as Claims” and Click Next 
Button.  

 

18. Enter the Following and Click Finish Button. 
 

Incoming claim type. Outgoing claim 
type. 

Outgoing name Id 
format 

http://sys09/internal/sessionid Name ID  Transient Identifier 
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19. Click “Add Rule” button and select the “Send LDAP attribute as claim” and Click Next Button 

 

 

20. Enter the Following and Click Finish Button. 
 Claim Rule name : Some Name 
 Select “Active Directory” from Attribute store 

LDAP Attribute Outgoing claim type. 
Token Groups – Unqualified Name Role 
UserPrincipalName Surname 
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21. Click Apply and OK button in “Edit Claim Rule” window. 
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Reference Links 

 

1. https://sourceforge.net/projects/portecle 
2. http://community.jboss.org/wiki/HowtoconfigurePicketlinkonTomcatwithMicrosoftADFSv2 
3. https://community.jboss.org/thread/153501 
4. http://blogs.msdn.com/b/card/archive/2010/02/17/name-identifiers-in-saml-assertions.aspx 
5. https://addons.mozilla.org/en-US/firefox/addon/saml-tracer/ 

 

 


